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The Academic and Administrative Centre of the Institute floated the seventh program on 

September 30, 2023 at 9.30 a.m. invoking the  blessings of Divine Almighty with a prayer song. 

The program was targeted at non-teaching of the higher education institutions across the country 

with the objective of enhancing their office productivity through capacity training on Microsoft 

Office and G-Suite training.  Dr. K. Ramya, the Programme Coordinator and Nodal Officer of 

AIU-AI-AADC, warmly welcomed attendees and offered a comprehensive overview of the three-

day event. 

 

 

 

Dr. V. Bharathi Harishankar, the Vice Chancellor of Avinashilingam Institute for Home Science 

and Higher Education for Women in Coimbatore, delivered the presidential address on the 

importance of embracing technology and transitioning to a paperless office. She emphasized that 

technology, much like computers today, is a powerful tool but not more powerful than human 

potential. 

 

Dr. Harishankar underscored the significance of technology as an assistant that can efficiently 

process and present data, enhancing productivity and reducing the chances of data manipulation. 

She stressed the need for academic institutions to adapt to technological advancements, not only 

among teaching staff but also administrative personnel. 

 

Dr. Harishankar highlighted that a paperless office fosters efficient workflows, reducing the 

temptation to overrule regulations. Furthermore, she discussed the importance of building tech-

savvy capabilities among administrators to cope with the increasing trend of online and blended 

learning in educational institutions. 

 



Dr. Harishankar encouraged participants to actively engage with technology, constantly 

improving their skills, and offering input to enhance processes. She concluded with the message 

that technology is a useful tool, but individuals are the ultimate decision-makers in effectively 

utilizing it. 

 

Day  1 

30/09/2023 @ 11.00 am – 04:30 pm 

Microsoft Word and PowerPoint 

Praveen Poulose E 

Engineer - Cyber Security Group 

Quadrasystems.net (India) Private Limited 

 

 

      
 

The informative and hands-on session on Microsoft Word and PowerPoint was skillfully handled 

by Mr. Praveen Poulose E, an Engineer from the Cyber Security Group at Quadrasystems.net 

(India) Private Limited, Coimbatore. 

 

Mr. Praveen initiated the session by introducing the fundamentals of Microsoft Office and went on 

to explain the significance of Microsoft 365. He described it as a cloud-based platform designed to 

enhance productivity, offering a subscription service that includes popular applications like Word, 

Excel, PowerPoint, and Microsoft Teams. What sets Microsoft 365 apart is its accessibility – it 

can be used on a variety of devices, from computers to mobile devices, both online and through 

installations on PCs, Macs, tablets, and phones 

 

He provided a brief historical context, noting that Microsoft first introduced Office 365 in October 

2010. In 2020, it was rebranded as Microsoft 365. This transition was complemented by Mr. 

Praveen's explanation of previous versions, including Office 2013, 2016, 2019, and 2021, and the 

key differences between Microsoft 365 and Office 2021. He also highlighted six core applications: 

Word, Excel, PowerPoint, Outlook, OneDrive, and Teams, each with its unique uses and benefits. 

 



     
 

Mr. Praveen emphasized Word's pivotal role as a powerful word processing software that allows 

the creation, saving, and printing of documents while facilitating collaboration with others.He 

provided valuable insights into the various practical applications of Microsoft Word such as 

creation of  resumes, notes, assignments, books, articles, email newsletters, reports, audits, legal 

documents and many more.  

 

Participants were then led through the Word interface, with each element explained in detail. From 

the File tab to the Quick Access Toolbar, from the Ribbon to the ruler, participants gained a 

comprehensive understanding of Word's layout and functionality. They explored elements like the 

status bar, view buttons, minimize, maximize, close, scroll bar, zoom control, document name, 

and dialogue box launcher, with hands-on training being an integral part of the experience. 

 

 

     
Mr. Praveen covered all the tabs within Microsoft Word, including File, Home, Insert, Design, 

Layout, References, Mailings, Review, View, and Help. He created example documents to 

showcase the practical application of each feature, ensuring that participants could apply their 

newfound knowledge effectively. 

 

In the Home tab, participants learned about essential functions such as cut, copy, paste, format 

painter, font type, font size, font color change, font alignment, find and replace options. Layout 

tab functions, including margin settings, page orientation, size, column, page setup, indent, and 

spacing, were also elucidated. Advanced options, such as spell and grammar checks, were 

demonstrated in-depth. 



 

Mailing options were also discussed, covering envelopes, labels, and mail merge processes.       

Mr. Praveen explained how to select recipients and edit recipients' lists, offering a comprehensive 

understanding of these important features. Step-by-step procedures for mail merges were clearly 

explained and demonstrated with practical examples.  

 

The Insert tab was the next area of focus, where participants learned to create cover pages, blank 

pages, tables, insert pictures and shapes, and manage hyperlinks and bookmarks. The session also 

covered how to utilize page headers, footers, and page numbers, along with creating text boxes for 

enhanced document structure. 

 

The latter part of the session shifted its focus to Microsoft PowerPoint. Mr. Praveen explained 

PowerPoint as a powerful presentation software that allows users to create impactful and engaging 

presentations and slideshows. 

 

 

       
 

The PowerPoint segment was divided into five key topics: navigating the PowerPoint interface, 

creating engaging presentations, managing slide transitions and animations, creating charts, 

adding comments, and rehearsing timings. A live example PowerPoint presentation was created 

and used to showcase all the available options, from file management to word art, inserting 

images, using slide transitions, and designing slides. 

 

Mr. Praveen also took a moment to reflect on how technology has evolved over time, emphasizing 

how PowerPoint presentations have become increasingly influential in conveying information. He 

highlighted the numerous advantages of using PowerPoint presentations, such as their visual 

appeal and the ability to present complex ideas with clarity. 

 

In conclusion, Mr. Praveen shared a Word tutorial link (https://edu.gcfglobal.org/en/word/#)  with 

participants and strongly encouraged them to practice and apply the skills they had acquired. The 

session offered a thorough and practical introduction to Microsoft Word and PowerPoint, 

equipping participants with the essential knowledge and skills to excel in their professional and 

academic endeavors. 

 

 

 

 

 

Day  2 



01/10/2023 @ 09.30 am – 04.40 pm 

Microsoft Excel and Outlook 

 

Thamizharasu C 

Manager - Strategic projects 

Quadrasystems.net (India) Private Limited 

 

                                      
 

Mr. Thamizharasu C, Manager of Strategic Projects at Quadrasystems.Net (India) Private Ltd, 

Coimbatore served as the resoure person for Day 2. The session commenced with a 

comprehensive introduction to Microsoft Excel, emphasizing its pivotal role as a versatile 

spreadsheet program used for recording, manipulating, and storing numeric data. He emphasised 

on Excel's adaptability, allowing users to customize it to match their preferences, making it an 

indispensable tool across diverse industries. 

 

Mr. Thamizharasu began the session with a detailed overview of the Microsoft Excel interface. He 

highlighted the significance of the Ribbon, a central component that grants quick access to a wide 

array of Excel commands. He further elucidated the Options dialogue window, a feature that 

empowers users to customize various elements, including the Ribbon, formulas, proofing, and 

saving preferences. 

 

 
The speaker underlined the omnipresence of Microsoft Excel across industries and reiterated its 

versatility and relevance in the professional world. To ensure a firm grasp of the basics, he 

meticulously covered key elements of the Excel interface, including the Quick Access Toolbar, 

Formula Bar, Ribbon, Spreadsheet Grid, and Status Bar. Each tab within the Excel interface, 

including File, Home, Insert, Page Layout, Formulas, Data, Review, and View, was explored and 

demonstrated in detail. 

 

 



Mr. Thamizharasu explained that a command is essentially an action that a user performs in Excel, 

such as creating a new document or printing. Participants were also advised on font selection, with 

Calibri being the default choice, while the professional font Times New Roman was suggested as 

an alternative for specific use cases. 

 

     
 

Participants were exposed to various components of the Ribbon, a brief of which is presented 

below:  

 Ribbon Start Button : This serves as the gateway to various commands, including creating 

new documents, saving existing work, printing, and customizing Excel options. 

 Ribbon Tabs: These tabs categorize similar commands together. For instance, the "Home" 

tab is dedicated to basic commands related to formatting data, sorting, and finding specific 

information within spreadsheets. 

 Ribbon Bars: Bars are used to group related commands together. For example, the Alignment 

ribbon bar groups commands used for aligning data effectively. 

 

Mr. Thamizharasu presented a comprehensive outlook of the Home tab, providing participants 

with insights into each available option. This included font formatting options such as bold, italic, 

underline, font size, text color, and alignment. The hands-on approach allowed participants to gain 

practical knowledge of the fundamental formatting tools available in Excel. 

 

The concept of worksheets was introduced, with Mr. Thamizharasu explaining that they are 

composed of rows and columns. The intersection of a row and a column forms a cell, which is 

used to record data. Each cell is uniquely identified using a cell address. Columns are typically 

labeled with letters, while rows are numbered. Workbooks, which contain multiple worksheets, 

were also discussed. Participants learned that workbooks typically have three default sheets named 

Sheet1, Sheet2, and so on, but these can be renamed to better suit the content, such as "Daily 

Expenses" or "Monthly Budget." 

 

                                                                                               

 

 

 

 

 

 

 

 

 



Mr. Thamizharasu shared a selection of vital keyboard shortcuts that can significantly enhance 

efficiency when working in Excel.  

 

 
 

The session further delved into various features within Excel, including formatting data as a table, 

utilizing cell styles, inserting and deleting cells, rows, and columns. Participants also learned 

about formatting cell size, row height, column width, and visibility options, including the ability to 

hide and unhide content. Additionally, attendees were educated on organizing sheets, renaming 

them for clarity, moving or copying sheets, applying tab colors for better organization, and 

exploring sheet protection. Sorting, working with pivot tables, and creating charts, including line 

charts and pie charts, were also demonstrated. 

 

Mr. Thamizharasu highlighted Excel's enduring status as the industry benchmark for financial 

analysis and modeling across corporate finance functions. He emphasized that mastering these 

fundamentals serves as the foundation for building confidence in Excel and for progressing to 

more complex functions and formulas. 

 

 

                       
 

Two fundamental approaches to calculations in Excel were presented: 

 

1. Formulas: In Excel, a formula is an expression that operates on values within a cell or a 

cell range. Mr. Thamizharasu elucidated various mathematical formulas, including SUM, 

COUNT, COUNTA, SUMIF, AVERAGE, ROUND, PRODUCT, and ROMAN, providing 

clear explanations and real-time examples for each. 

 

2. Functions: Functions, which are predefined formulas in Excel, simplify complex 

calculations by providing them with user-friendly names. The SUM function, a crucial example, 

was explained in detail to illustrate its utility in aggregating values from selected columns or 

rows. 

 

 

 



Mr. Thamizharasu provided comprehensive explanations and real-time examples for essential 

Excel formulas: 

 

1. SUM: The SUM function, a fundamental Excel formula, aggregates values from selected 

columns or rows within a specified range. Examples were provided to illustrate various use 

cases. 

  

                            
 

2. AVERAGE: The AVERAGE formula calculates the average of data in a given range. 

Real-world examples showcased its practical application. 

 

3. COUNT: The COUNT formula was explained, highlighting its role in counting cells 

containing only numeric values within a given range. Participants learned to adjust the formula 

range to count rows effectively. 

 

4. TRIM: The TRIM function was introduced as a tool to ensure that functions do not 

return errors due to extra spaces in data. The example demonstrated how TRIM can eliminate 

extra spaces within a cell. 

 

A significant portion of the session was dedicated to creating hyperlinks in Excel and linking one 

sheet to another. Real-time examples were showcased to effectively address participants' queries 

and ensure a thorough understanding of this valuable feature. 

 

In the session's concluding segment, Mr. Thamizharasu passionately encouraged all participants to 

practice the various formulas and functions they had learned. He compared Excel to an ocean, 

emphasizing the importance of continuous learning and improvement. In a professional and 

motivational closing remark, he underscored the value of ongoing education and practice, leaving 

participants inspired to explore the vast capabilities of Excel further. 

 

 

 

 

 

 

 

 

 

 

 

 

 



Day  3 

02/10/2023 @ 09.30 am – 04.40 pm 

G-Suite Applications  

 

Ms. Saraswathi. P 

Trainer, Cloud Reign Technologies  

 

 
 

On the third and final day of the training program led by Ms. Saraswathi P of Cloud Reign 

Technologies, Coimbatore, participants were exposed to various Google Workspace applications 

and their extensive functionalities. The training was thoughtfully divided into two distinct parts, 

with the first session focusing on Google Meet, Gmail, and Google Calendar, and the second 

session covering Google Drive, Google Docs, Google Sheets, Google Slides, and Google Forms. 

 

      
 

In the initial session, Ms. Saraswathi illuminated the path to effectively engage in online events 

through Google Meet. The participants were guided through the extra capabilities of Google Meet, 

both in the desktop and mobile versions. This hands-on demonstration was instrumental in 

ensuring that attendees were well-prepared to maximize their use of Google Meet for virtual 

meetings and events. 

 

Transitioning to Gmail, Ms. Saraswathi explored a wide range of topics. She initiated the session 

by delving into the fundamentals of email. Then, the participants were provided with practical, 

hands-on training to showcase the basic and advanced capabilities of Gmail. Key areas of focus 

included: 

 Creating Teams in Gmail: Participants learned how to set up teams within Gmail, 

streamlining communication within organizations. 

 



              
 

 Utilizing Google Snippets: This feature was demonstrated as a time-saving tool, allowing 

users to create emails more efficiently by utilizing symbols and shortcuts. 

 Scheduling Messages: Participants were guided on how to schedule messages for future 

delivery, allowing for timely communication even when they couldn't be present to send 

messages in real-time. 

 

Ms. Saraswathi also took time to elucidate the various settings options available within Gmail, 

including: 

 Language Preferences: She showcased the ease with which users can customize the 

language settings to better suit their needs. 

 Undo Option: Participants were shown how to increase the visibility of the Undo option after 

sending a message, providing a valuable safety net for those last-minute changes. 

 Font Size Adjustments: The session covered how to modify font sizes to cater to individual 

preferences. 

 Signature Creation: Participants learned how to craft unique email signatures that leave a 

professional mark. 

 Managing Multiple Email IDs: Ms. Saraswathi explained how to set up and manage 

multiple email IDs with distinct signatures, eliminating the need for repetitive customization. 

 

Moreover, the Label option was highlighted for its potential to filter emails based on sender and 

recipient, simplifying email organization. Various other configuration options, including accounts 

and import, filters, prohibited addresses, chat, and meet, were explored in detail. 

 

Google Calendar was another essential aspect of the first session. Ms. Saraswathi shared insights 

into the default calendar and demonstrated how to create additional calendars tailored to 

individual needs. Key takeaways from this segment included: 

 Color-Coding Events: Participants discovered how to assign different colors to various types 

of events for easy visual differentiation. 

 Scheduling Google Meet Links: The practical demonstration showed how to seamlessly 

schedule Google Meet links for virtual gatherings. 

 Pop-Up Notifications: The session explained how to enable and manage pop-up notifications 

during video calls. 

 

 

 

 



         
 

 

 Scheduling Meetings with a Code: Participants were shown how to schedule meetings in 

Google Calendar using a unique meeting code, illustrated through the example of the code 

"CBP." 

 Customized Appointment Schedules: Attendees learned how to create appointment 

schedules tailored to their specific preferences and set focus times for notifications when 

selected slots were unavailable. 

 

The significance of Google Drive in managing data access was also emphasized. Participants 

gained insight into shared drives, a feature that enables multiple users to access data folders or 

files while receiving automatic updates, streamlining collaboration and eliminating the need for 

frequent file sharing. 

 

The second session delved into content management using a suite of Google's productivity tools. 

Notable highlights included: 

 

        
 

 Automatic Saving in Google Docs: Participants learned that data is saved automatically in 

Google Docs, obviating the need for manual saves after each modification. 

 Sharing Documents in PDF Format: Attendees discovered how to share documents as 

PDFs via email, a convenient way to distribute and collaborate on documents. 

 Obtaining Approval for Document Edits: The session emphasized the importance of 

approval for document edits, with options for allowing or restricting further changes. 

 Timer Button for Editing History: The Timer button was demonstrated as a valuable tool 

for tracking team members' editing history, even if the system goes offline. 



 Explore Options: Ms. Saraswathi explored the Explore feature, which allows users to 

directly insert images from their web browser and translate entire documents into different 

languages. 

 Activity Dashboard: The activity dashboard was introduced as a tool to monitor document 

views and trends among team members. 

 Instant Meeting Start: A unique feature was mentioned, enabling participants to initiate an 

instant meeting from Google Docs without manually creating a Google Meet link. 

 Google Sheets Capabilities: The session highlighted Google Sheets' ability to track edits and 

send email notifications for changes. 

 

In summary, Ms. Saraswathi P's training sessions offered a comprehensive understanding of 

Google Workspace applications, enabling participants to effectively use these tools for enhanced 

productivity and collaboration in their professional endeavors. 

 

             
 

 

Dr. K. Ramya, the Programme Coordinator and Nodal Officer of AIU-AI-AADC, presented a 

comprehensive report on the Seventh Short-Term Capacity Building Programme, themed 

'Enhancing Office Productivity: Microsoft Office and G-Suite Training for Non-Teaching Staff.'  

Dr. Ramya lauded the effectiveness of the session speakers, whose thoughtful deliberations 

rendered the program productive, immensely useful, and perfectly timed. She also extended her 

sincere gratitude to the session speakers for generously sharing their valuable experiences with the 

participants, enriching the program's impact and contributing to professional growth. 
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150 S.Abiviruthi Lab Assistant Ksr Institute Of Engineering Technology  

151 Yuvraj Prabhakar Chavan  Technical Assistant Kjsieit 

152 Menisha a Lab Technician  Sona College Of Technology 

153 Bhavin Shah Asst.Director- Industry 

Academia Partnership Cell 

Parul University  

154 A.S.Geetha Programmer Ksr Institute Of Engineering Technology  

155 Tamilarasi Library Assistant Sona College Of Technology 

156 Suryaa R S Office Assistant Avinashilingam Institute For Home Science And 

Higher Education For Women 

157 A.Santhi Office Assistant Avinashilingam Institute For Home Science And 

Higher Education For Women 

158 Priyadharshini A Laboratory Assistant Avinashilingam Institute For Home Science And 

Higher Education For Women 

159 G. Uma Multi Task Assistant Avinashilingam Institute For Home Science And 

Higher Education For Women 

160 A. Sivaranchini Stenographer Avinashilingam Institute For Home Science And 

Higher Education For Women 

161 Kumar K Office Assistant Avinashilingam Institute For Home Science And 

Higher Education For Women 
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162 Shobika G Multitask Assistant Avinashilingam Institute For Home Science And 

Higher Education For Women 

163 P Jegatheswari Multi Task Assistant  Avinashilingam Institute For Home Science And 

Higher Education For Women 

164 Dhanabagyam k Multitask Assistant Avinashilingam Institute For Home Science And 

Higher Education For Women 

165 Kumaresan C Tr.Lab Technician  Sona College Of Technology 

166 A. Prabu Technician Sona College Of Technology 



 

 

 

 

 

 

 

                                                       

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 


